telestream %~ ScreenFlow 8

Release Notes

ATTENTION all previous version customers!

Version 8 is a paid upgrade and requires a new serial number if you are upgrading from versions 4 or 5. Version 6 and 7
users will retain the same serial number when upgrading to version 8. Versions 1, 2, and 3 are not eligible for upgrade
pricing.

If you install version 8 without purchasing a new license or upgrade, your videos exported from ScreenFlow 8 will
contain a watermark until you have entered a valid version 8 serial.

To obtain the upgrade pricing:

e \Version 6+:
O Your serial number must either be activated in the ScreenFlow Preferences> License panel before
initiating the upgrade process, or you may use our Web Upgrade Tool.
e Version4and5:
O Youmust use our Web Upgrade Tool.

Mac App Store Customers:
Unfortunately, the Mac App Store does not allow for product upgrades. If you missed the launch day pricing, you
have three options:

1. You can purchase ScreenFlow 8 from the Mac App Store at full price. This option would allow you to run
ScreenFlow on as many devices as the Mac App Store allows.

2. You may use our Web Upgrade Tool to obtain upgrade pricing. This will require that you transfer your
license to a Telestream license, upgrade to ScreenFlow 8, and run it on one device at a time per the
Telestream EULA.

3. Ifyou are running Mac App Store ScreenFlow version 6.2.3 or 7.3.1 and it is no longer operational, you can
transfer your license to a Telestream license and you will be issued a complimentary version 6.2.4 or 7.3.2
serial number which have compatibility fixes to operate on macOS 10.13 High Sierra and macOS 10.14
Mojave respectively.

Differences between Telestream version and Mac App Store version

System Requirements

e Intel-based! Mac? with 64-bit processor - Core i3+ recommended
e Operating Systems
o macOS 10.12 Sierra, macOS 10.13 High Sierra, & macOS 10.14 Mojave
Minimum 2 GB RAM
e 20 GB hard drive
Apple macOS approved graphics card®* required
Cameras using the DV and/or HDV codec are not supported. Click here to learn more.

intel GMA chips are unable to support Motion Blur and some Callout features
2ScreenFlow does not support “Hackintosh” systems
3ScreenFlow requires a GPU officially supported by Apple

*ScreenFlow does not support NVIDIA “Web Drivers”
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8.2.2 - Changes

Fixes:

e FIXED - In some scenarios, making edits/changes and undoing can show a SCUndoManager Runtime Error

8.2.1 - Changes

Fixes:

e FIXED - Document Settings option causes "Cannot find document properties" Error when re-opening project

8.2 - Changes

Improvements:

e IMPROVED - Added messaging for customers who are opening projects from Dropbox

o IMPROVED - Renamed Camera and Screen Recording Template Placeholder clips to “Camera and
Microphone” and “Screen Recording and Computer Audio” respectively.

o IMPROVED - Stock Media Library - Added the ability to specify the format to download

Fixes:

e FIXED - ScreenFlow crashes when applying Chroma Key to media files

e FIXED - Canvas does not appearin 10.14.1 (18B67a) for ScreenFlow projects

o FIXED - Reverse Clip no longer works correctly after update

e FIXED - JVC camera files unplayable in ScreenFlow 8

e FIXED - Error locating file message shows after renaming a document then making a split

e FIXED - Removed Actions Templates from ScreenFlow Ul

e FIXED - Show Keystrokes Accessibility message not localized

e FIXED - Unable to use shortcut keys to jump scrubber from beginning/end of media in Timeline while the
Timeline is detached

e FIXED - Able to add multiple copies of 'recording' files to the Global Library

e FIXED - By default 'Stereo' is not selectable on the display thumbnails/waveforms menu

o FIXED - 2160x3840 resolution files display incorrectly in ScreenFlow

o FIXED - 848x360 resolution files display incorrectly in ScreenFlow

o FIXED - 720x404 resolution files display incorrectly in ScreenFlow

e FIXED - New sections of publishing to YouTube not showing as being localized

e FIXED - Font Menu>Make Text Properties Default never becomes active

e FIXED - Audio/Video filter sliders/options show reverse order when comparing to older versions of ScreenFlow

e FIXED - Publish to YouTube second window not localized when system language is set to Spanish

e FIXED - Camera and Microphone access prompts are not localized

FIXED - Creating a New Document activates the 'Undo' from the Edit menu.

FIXED - German translation of 'light' motion blur is incorrect

FIXED - Stock Media - Previews Do Not Play while Downloading to Timeline

FIXED - Stereo waveforms do not show properly when track thumbnails is on

e FIXED - 'Select parameters to store in styles' is cut off when ScreenFlow is in German
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8.1 - Changes

Improvements:

e IMPROVED - Stock Media - Add a Beats per Minute (BPM) option in the Metadata/Filtering section
e IMPROVED - Separate Template Placeholders for Mic and Computer Audio
e IMPROVED - Ability to make multiple templates from an existing template

Fixes:

o FIXED - .SCC files getting corrupted when working with project saved to Dropbox.

e FIXED - Adding a clip from a .scc file with multiple clips adds all clips to the Global Library

o FIXED - Annotations Ul displays incorrectly after 'Reset to Defaults' or applying a Style

e FIXED - Cannot save regular ScreenFlow document with same name as template

e FIXED - Cannot save the project - error "The document Untitled" could not be saved File name too long.

e FIXED - Cannot Scroll within Detached Timeline

e FIXED - Clicking Top Menu>Window=>Zoom while detached timeline is selected causes preview window to
zoom instead

e FIXED - Crash when quickly opening and closing video preview

e FIXED - Deleting a file from the Global Library doesn't remove the file from the Timeline

e FIXED - Do not show Dark/Light mode options for ScreenFlow on Mojave OS; follow system preference for
light/dark mode

e FIXED - Dragging a Screen Recording and Microphone recording to the timeline shows incorrect order

e FIXED - Exiting ScreenFlow before a Stock Media file downloads will cause the loss of the media file from the
saved document

e FIXED - Expired text does not show in Licenses Tab of Preferences when a Stock Media Library entitlement has
expired

e FIXED - Files added to the global media library in version 7 do not appear in version 8

e FIXED - Having 'Detached Timeline' selected grays out Export option from the file menu.

e FIXED - HEVC file crashing ScreenFlow when added to timeline.

e FIXED - Item is removed from global library if a file with the same name is added twice.

e FIXED - Keyboard shortcuts for timeline controls do not affect the detached timeline when it is selected

e FIXED - Mojave - Keystroke 'Command Z' crashes ScreenFlow after adding a clip to timeline.

e FIXED - Mojave - Undoing Replace media results in broken display on canvas.

e FIXED - Mojave- Editing canvas resolution shows choppy/delayed behavior

e FIXED - New Hotkeys are not shown as they are entered on Mojave

e FIXED - Only modifier keys are shown with Show Keystrokes on Mojave

e FIXED - Only one file is added to the Canvas/Timeline when dragging multiple files from the Media Library on
mac0S 10.14

o FIXED - Partial Screen Capture runs into Accessibility access message which causes beach ball non-responsive
state.

o FIXED - PDF causes scaling error when using Replace Media

e FIXED - Preset drop down menu within the New Document tab showing incorrect length

e FIXED - Record from iOS device is cut off when ScreenFlow is in French

e FIXED - Removing Video Filter results in Video Properties Panel displaying incorrectly

e FIXED - Replace media results in broken display on canvas
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e FIXED - Right-click menu in Media Library does not function when selecting all media using shortcut key
cmd+a

e FIXED - Save as Template window can be resized on Mojave

e FIXED - Save Frame JPG has a PNG file extension

e FIXED - Scale buttons do not work after an action

e FIXED - ScreenFlow App 'breaks' after selecting undo from the Edit menu on 10.14 Beta

e FIXED - ScreenFlow crashes after undoing the creation of a nest on 10.14 Beta OS

e FIXED - Selecting Reset to Defaults from the Audio Mix gear menu shows an Unrecognized selector Runtime
Error if used after an Audio Action

e FIXED - Show Thumbnail selection not working from contextual menu.

e FIXED - Sliders within dropdowns in the Inspector panel are exposed outside of the dropdowns on Mojave

e FIXED - Some buttons don't contrast well on Mojave

e FIXED - Spelling error in the unrecognized format notification.

e FIXED - Starting playback of audio in ScreenFlow 8 while using Bluetooth headsets causes audio to play
through internal speakers

e FIXED - Stock Media Cannot Be Previewed Error...

e FIXED - Stock Media Library html page is resizable

e FIXED - Thumbnail state is ignored when closing and reopening a project after changing what Thumbnails to
display

e FIXED - Update "New Documents" to include presets for iPhone X

o FIXED - Welcome screen activates the user’s camera even when option is not selected.

o FIXED - White highlights showing when ScreenFlow is in Dark Mode Ul on 10.14 OS
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8.0 - New Features

What’s New:

e Stock Media Library - Gain access to an always growing library of well over 500,000 images, audio,
video clips and more with ScreenFlow’s new built in Stock Media Library. Browse the library and add
transitions, motion backgrounds, royalty-free backing tracks and more simply by dragging them to
your timeline from the Stock Media Library tab! (Additional Fee).

e Track Thumbnails - Now you can see a quick and easy visual representation of your content via
thumbnails displayed over the duration of a media file. Easily identify scene changes and areas of
interest. No need to scrub through content to find specific moments!

e Styles - Always want your camera in a certain spot with specific filters and a drop shadow? Well,
regardless of the edits you make to any assets in your projects, you can now save those settings as
“Styles” to easily re-use over and over. A massive time saver. Combine with templates for a mostly
automated workflow!

e Templates - If you make multiple videos with a similar format, ScreenFlow’s new Templates feature
will save a ton of time! Simply create the template using placeholders for your camera, screen, or i0OS
recording, then add any other recurring media. Now when you finish recording, all your assets are
already placed in the correct spot in the timeline and canvas! Combine with Styles applied to your
placeholders for a mostly automated workflow!

e Quick Narration & Voice-Over Additions - Need to record a quick audio clip? Quick narrations allow
you to add narrations or voice-overs without leaving the timeline or configuring a traditional
recording.

e Detachable Editing Timeline - The new detachable editing timeline allows for a more customizable
editing experience and enables multi-monitor editing by separating the editing timeline and canvas
on to different monitors.

e Additional Timeline Frame Rates - Additional Timeline Frame Rates of 24, 25, and 50 have been
added. These are in addition to the existing 30 and 60 options.

e Export Animated PNG (APNG) Files - ScreenFlow now supports APNG export. Like GIF’s, APNG’s are
single file moving pictures that support transparent backgrounds but allow for higher quality and
smaller sizes!

e Freehand Annotation - Custom shapes and lines can now be drawn directly onto the ScreenFlow
canvas for highly customizable annotations.

e Instagram Project and Export Presets - Uploading to Instagram? ScreenFlow has you covered with
built in project dimensions and export settings specific to everyone’s favorite social image site!

> Instagram requires user to copy exported video to phone to publish.

e Frame for Selected Monitor - When choosing your recording monitor, a red frame now indicates the
current selection...no need to remember monitor model numbers!

e H.265/HEVC Decoding - Previously, HEVC could only be exported in ScreenFlow 7. You can now
import and edit files encoded with HEVC such as iPhone X 4k recordings.
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Arrange Menu - Various new options such as alignment, scale, and distribute allow you to more
quickly arrange your media within your project.

Auto-Scale Large Imports - ScreenFlow will now automatically scale imported media to fit the
canvas if the dimensions of the media are larger than the canvas.

Burn in Captions on Export - You can now burn-in captions if you need captions in a player that does
not support caption tracks. Simply check the box during export.

Content-Type Badge for Items in Media Libraries - Media within your library now has a badge
overlay depicting the type of media for easier identification.

Keyboard Shortcuts for "Close Gap" - Users can now set a custom keyboard shortcut for the “close
gaps” function. Multi-select gaps and close with one shortcut.

Media Library Filtering System & Metadata Panel - New filtering system for the media libraries with
metadata display tab. Click the filter button in the library pane to display.

Preview Audio and Video in Libraries Without Adding them to the Timeline - Audio and video files
in libraries can now be previewed without first adding them to the timeline.

Save Frame as JPEG - Quickly export the current content as a still JPEG image.

Select Which Audio Channels are Recorded with Audio Interface Devices - Users can now select
specific channels to record of a multi-channel audio interface. You no longer need to record all
available channels.

Support Decoding MOV PNG Files - You can now add and work with MOV PNG files in ScreenFlow.

Support for GoPro CineForm Codec - ScreenFlow now supports the GoPro CineForm codec for
import and editing.

Specify the Thumbnail Image for a YouTube Published Export - Now when publishing directly to
YouTube, you can use ScreenFlow to select the image to be used as the YouTube thumbnail.

Upload to YouTube on a Schedule - When publishing to YouTube, you can now select and schedule a
time in which you would like the video to be published.
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8.0 - Improvements & Fixes

Improvements:
e IMPROVED - Add custom shortcut options for captions Play/Previous/Next functions

e IMPROVED - Allow recordings to be added either in sequence or layered when being added to the
timeline

e IMPROVED - Enable duration labels by default in the media libraries

e IMPROVED - Media replacement will now maintain the same proportions as the piece being replaced
e IMPROVED - Reword "Publish to Selected Range" menu item to "Publish Selected Range to"

e IMPROVED - Show duration of selected clip in the bottom project duration display area

e IMPROVED - Show the full name of a media file in the Media Library when the cursor hovers over it

e IMPROVED - Show the Scratch Disk folder path in Preferences

e IMPROVED - State that there were no results to display when a search returns no results in the
libraries.

e IMPROVED - Uncheck 'Record Computer Audio' when the user changes versions

e IMPROVED - Update Apple iOS devices preset export options

Fixes:

e FIXED - 1/2 second Exports Hang ScreenFlow indefinitely (30 & 60fps).

e FIXED - Able to make the frontend window full screen on 10.13.

e FIXED - Add to timeline stacked puts clips stacked in reverse order from original recording.

e FIXED - Adding a new video recording + audio recording to an already open project, adds the files in
sequence.

e FIXED - APNG preview in media catalog appears as a static image.
e FIXED - Apple Lossless Audio clips not playing in timeline.

e FIXED - Audio filters that are specified with a percentage value, require user to enter the % symbol
after the value, otherwise value is treated as invalid.

e FIXED - Audio mix reset option changes channels to be L and R instead of how they were set at the
beginning of the recording

e FIXED - Audio Unit Ul does not display correctly on first use

e FIXED - Can no longer input custom percentage for resolution on export

e FIXED - Certain H264 .MOV files will open in ScreenFlow but video and audio will not play

e FIXED - Clips are not normalized correctly when pasting between different FPS timelines

e FIXED - Double clicking a. SCC file in media catalog can sometimes add the incorrect clip to timeline
e FIXED - Export resolution doesn't change when preset is changed to iPhone, iPad, etc.
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e FIXED - Freehand Rectangle Callout shifts the entire clip on the canvas a few pixels (Partial Screen
Capture Only)

e FIXED - Improve demo version messaging to ensure users are aware they are in demo mode
e FIXED - Make Settings Default function not affecting annotations

e FIXED - Pasting annotation from a different canvas sizes, offsets the bounding box
e FIXED - Photo JPEG .MOV files not displaying in ScreenFlow 7

e FIXED - Recent Documents - Text is hard to read when using the Light Ul theme

e FIXED - Relink icon disappears after closing and relaunching ScreenFlow

e FIXED - Right clicking in timeline negates multi-selection of gaps

e FIXED - Right-click context menu does not update to show changed shortcut keys
e FIXED - Save custom mouse pointer

e FIXED - Screen recording pointer is not reset with Reset to Defaults

e FIXED - Scroll bar not showing properly in video and text property tabs

e FIXED - Some MPEG-1 files have issues playing back in ScreenFlow

e FIXED - Support MOV PNG files

» NOTE: These are inherently taxing and may not play back smoothly during editing. This
does not affect the final output when exporting from ScreenFlow.

e FIXED - Thumbnails between the left and right-side Media Libraries do not update correctly when
relinking media

e FIXED - Welcome Screen text aligns improperly when window is enlarged

Version 8.0 contains hundreds of bug fixes, not all of which can be listed here. There are also additional user interface/user
experience enhancements, and improvements to the general stability and performance of the application, that are not able to
be listed here.
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